Copyright © 2016 EMC Corporation. All rights reserved. Published in the USA.

Published February 2016

EMC believes the information in this publication is accurate as of its publication date. The information is subject to change without notice.

The information in this publication is provided as is. EMC Corporation makes no representations or warranties of any kind with respect to the information in this publication, and specifically disclaims implied warranties of merchantability or fitness for a particular purpose. Use, copying, and distribution of any EMC software described in this publication requires an applicable software license.

EMC², EMC, and the EMC logo are registered trademarks or trademarks of EMC Corporation in the United States and other countries. All other trademarks used herein are the property of their respective owners.

For the most up-to-date regulatory document for your product line, go to EMC Online Support (https://support.emc.com).
PREFACE

As part of an effort to improve its product lines, EMC periodically releases revisions of its software and hardware. Therefore, some functions described in this document might not be supported by all versions of the software or hardware currently in use. The product release notes provide the most up-to-date information on product features.

Contact your EMC technical support professional if a product does not function properly or does not function as described in this document.

Note: This document was accurate at publication time. Go to EMC Online Support (http://support.emc.com) to ensure that you are using the latest version of this document.

Purpose

This document describes how to configure and use the EMC® Monitoring and Reporting Suite.

Audience

This document is intended for VNX and VNXe storage administrators and IT generalists who will be involved in managing VNX Family Monitoring and Reporting.

Conventions used in this document

EMC uses the following conventions for special notices:

⚠️ DANGER

DANGER indicates a hazardous situation which, if not avoided, will result in death or serious injury.

⚠️ WARNING

WARNING indicates a hazardous situation which, if not avoided, could result in death or serious injury.

⚠️ CAUTION

CAUTION, used with the safety alert symbol, indicates a hazardous situation which, if not avoided, could result in minor or moderate injury.

⚠️ NOTICE

NOTICE is used to address practices not related to personal injury.

Note: A note presents information that is important, but not hazard-related.
**IMPORTANT**
An important notice contains information essential to software or hardware operation.

**Typographical conventions**

EMC uses the following type style conventions in this document:

**Bold**

Use for names of interface elements, such as names of windows, dialog boxes, buttons, fields, tab names, key names, and menu paths (what the user specifically selects or clicks).

**Italic**

Use for full titles of publications referenced in text.

**Monospace**

Use for:
- System output, such as an error message or script
- System code
- Pathnames, filenames, prompts, and syntax
- Commands and options

**Monospace italic**

Use for variables.

**Monospace bold**

Use for user input.

[]

Square brackets enclose optional values

|

Vertical bar indicates alternate selections — the bar means “or”

{}

Braces enclose content that the user must specify, such as x or y or z

...

Ellipses indicate nonessential information omitted from the example

**Where to get help**

EMC support, product, and licensing information can be obtained as follows:

**Product information** — For documentation, release notes, software updates, or information about EMC products, go to EMC Online Support at:

[http://support.emc.com](http://support.emc.com)

**Technical support** — Go to EMC Online Support and click Service Center. You will see several options for contacting EMC Technical Support. Note that to open a service request, you must have a valid support agreement. Contact your EMC sales representative for details about obtaining a valid support agreement or with questions about your account.

**Your comments**

Your suggestions will help us continue to improve the accuracy, organization, and overall quality of the user publications. Send your opinions of this document to:

[techpubcomments@emc.com](mailto:techpubcomments@emc.com)
CHAPTER 1
Introduction

This introduction includes the following topics:

- Summary of VNX Family Monitoring and Reporting ........................................ 8
- Architectural Overview .................................................................................. 10
Summary of VNX Family Monitoring and Reporting

EMC VNX Family Monitoring and Reporting is a software solution that extends Unisphere element manager capabilities by providing unified performance and capacity trending information of VNX and Next-Generation VNXe storage systems. This solution complements Unisphere health alerts and Unisphere Analyzer.

VNX Family Monitoring and Reporting automatically collects Block, File, and VNXe storage statistics. It also collects configuration data and stores it in a database that can be viewed through dashboards and reports. This solution can retrieve information from one or several VNX®, Next-generation VNXe®, CLARiiON®, and Celerra® storage systems qualified for support. Monitoring and Reporting is a versatile solution to help you understand storage utilization and workload patterns. It also helps with problem diagnosis, trend analysis, and capacity planning.

The VNX Family Monitoring and Reporting web portal is a comprehensive dashboard that provides multiple ways to access reports quickly and effectively using the navigation tree, search engine, global views, and drill-down facilities. For example, the System Summary shows the hardware model, operating environment version, system-level aggregated capacity utilization, and performance overview. Drill-down into Block storage shows lower level reports such as pools, LUNs, FAST Cache, and FAST VP. The graphical user interface allows you to filter, sort, search, and link to other views to determine the cause-and-effect relationships.

The dashboard views are categorized by key topics such as Inventory, Performance, Capacity, Situations to Watch, Top N Reports, Service Levels, and Trending and Forecasting. These views include targeted and most active reports, technical graphs and tables, visual alerts against thresholds, key performance indicators, deviation analysis, and forecasting to help you plan for future growth. All reports display the latest available collected data and historical data. Historical data is aggregated over time as it ages according to the retention policy.

VNX Family Monitoring and Reporting provides a set of preconfigured reports, known as the ReportPack. You can export reports into various formats, change the report configurations, change the dashboard views, and save reports to your favorites.
Dashboards and Reports

VNX Family Monitoring and Reporting includes the following features:

- **Out-of-the box Dashboards** summarize information in the form of graphs, charts, and tables. Dashboards enable you to quickly pinpoint utilization and performance problems. From this top perspective, you can drill down to underlying reports to get more detailed views of a selected component. Individual users can arrange the layout of the dashboard to suit business requirements.

- **A multitude of specific reports** present information specific to one component or a group of components. The web portal provides users with several tools to refine the presented data and visualize it from different angles for better troubleshooting.

Reports can run on-demand. Report options include graphs and tables and output formats include CSV, XLS, XML, and PDF.

Built-in dashboards and reports include:

<table>
<thead>
<tr>
<th>VNX Block Reports</th>
<th>VNX File Reports</th>
</tr>
</thead>
<tbody>
<tr>
<td>Capacity utilization of one or multiple VNX systems</td>
<td>File storage capacity utilization of one or multiple VNX systems</td>
</tr>
<tr>
<td>Block services summary of one or multiple VNX systems</td>
<td>File services summary of one or multiple VNX systems</td>
</tr>
<tr>
<td>SP utilization and performance</td>
<td>(File) Storage pool capacity</td>
</tr>
<tr>
<td>Cache performance</td>
<td>File system capacity, including snapshot utilization and compress/deduplication savings</td>
</tr>
<tr>
<td>FAST Cache performance</td>
<td>File system capacity forecast</td>
</tr>
<tr>
<td>FAST VP performance by tier</td>
<td>DataMover CPU utilization and performance (CIFS/NFS)</td>
</tr>
<tr>
<td>Storage pool capacity and performance, including thin oversubscription</td>
<td>DataMover file system capacity, including snapshot utilization and compress/deduplication savings</td>
</tr>
<tr>
<td>RAID group capacity and performance</td>
<td>VDM file system capacity, including snapshot utilization and compress/deduplication savings</td>
</tr>
<tr>
<td>LUN capacity and performance</td>
<td>Top N users performance (DataMover, CIFS/NFS)</td>
</tr>
<tr>
<td>Disk capacity and performance</td>
<td>Top N file systems performance (DataMover)</td>
</tr>
<tr>
<td>Port utilization and performance</td>
<td>Replication session (DataMover, VDM)</td>
</tr>
<tr>
<td>Top N active hot spots</td>
<td></td>
</tr>
<tr>
<td>Performance baseline deviation</td>
<td></td>
</tr>
<tr>
<td>Compressed LUNs Summary</td>
<td></td>
</tr>
<tr>
<td>SnapShots Summary</td>
<td></td>
</tr>
</tbody>
</table>

For a summary of VNXe reports, refer to Appendix A.
Introduction

Database and Analytics

As hundreds of raw metrics are collected from storage systems and stored in the database for aggregation, normalization, and correlation, Monitoring and Reporting continuously processes the data to perform statistical analysis and evaluate pre-configured KPI thresholds as Block, File, and VNXe metrics are collected.

Administration

The Administration area is where the Monitoring and Reporting administrator manages day-to-day tasks from a simple web interface. This allows you to manage user roles and profiles, monitor the health of the Monitoring and Reporting server, see the status of servers, execute tasks, configure Alerts and Chargeback, and perform install and upgrade operations.

Architectural Overview

The Monitoring and Reporting architecture includes the following components:

<table>
<thead>
<tr>
<th>The Data Collector</th>
<th>Collects data, in an agentless way, from one of multiple systems.</th>
</tr>
</thead>
<tbody>
<tr>
<td>The Data Repository</td>
<td>Stores the data collected from the data sources. The database module is self-maintaining and provides multiple automations. For example, data aggregation is performed for report acceleration and data retention is managed for storage optimization.</td>
</tr>
<tr>
<td>The Web Portal</td>
<td>Displays operations, engineering, and management dashboards to users. Users have multiple ways to access information quickly and efficiently using a navigation tree, search engine, report wizard, or drill-down facilities.</td>
</tr>
</tbody>
</table>

Please refer to Appendix B, “Communication Ports,” for the list of ports used by the application.
CHAPTER 2
Installing

This chapter discusses information and procedures for the following topics:

- Environment and system requirements ......................................................... 12
- Installing on Linux .......................................................................................... 14
- System start .................................................................................................... 17
- Uninstalling .................................................................................................... 18
- Upgrading ....................................................................................................... 18
Environment and system requirements

The host system on which VNX Family Monitoring and Reporting is installed must meet the minimum requirements outlined in the following sections.

Host system requirements

The VNX Family Monitoring and Reporting software must be installed on a Windows Server 2008 R2, Windows Server 2012 R2, or a Linux (RedHat or CentOS) dedicated server. The operating system should be the latest version recommended by the vendor.

Naviseccli must be installed on the VNX Family Monitoring and Reporting host system for VNX systems as Naviseccli commands are used to communicate with the storage array. EMC recommends installing the latest version of Naviseccli for the latest storage system model which you are monitoring with Monitoring and Reporting. For more information on Naviseccli and operating environment compatibility, refer to the release notes for your storage system or the E-Lab Interoperability Matrix on EMC Online Support.

The host system must meet the following hardware requirements:

<table>
<thead>
<tr>
<th>1 system</th>
<th>2 CPU cores, 8GB RAM, 200GB of disk space.</th>
</tr>
</thead>
<tbody>
<tr>
<td>2-3 systems</td>
<td>4 CPU cores, 16 GB RAM, 400 GB of disk space.</td>
</tr>
<tr>
<td>Up to 10 systems</td>
<td>8 CPU cores, 32 GB RAM, 600 GB of disk space.</td>
</tr>
</tbody>
</table>

Monitoring and Reporting can run as a guest VM in a virtualized environment.

Browser Requirements

The VNX Family Monitoring and Reporting web portal is compatible with the following browsers:

- Internet Explorer 9 and 10
- Firefox (latest)
- Chrome (latest)
- Safari 5.1.1 or later
**Supported Platforms**

VNX Family Monitoring and Reporting is compatible with array products listed in the following table:

<table>
<thead>
<tr>
<th>Model</th>
<th>Operating Environment</th>
</tr>
</thead>
<tbody>
<tr>
<td>VNXe 3200</td>
<td>VNXe OE 3.0</td>
</tr>
<tr>
<td></td>
<td>VNXe OE 3.1.0, 3.1.1</td>
</tr>
<tr>
<td>VNX 5200, 5400, 5600, 5800, 7600, 8000</td>
<td>OE for File 8.1, 7.1, 5.33</td>
</tr>
<tr>
<td>VNX 5100, 5300, 5500, 5700, 7500</td>
<td>OE for File 7.0, 5.31, 5.32</td>
</tr>
<tr>
<td>VNX Gateways VG10, VG50</td>
<td>OE for File 8.1</td>
</tr>
<tr>
<td>VNX Gateways VG2, VG8</td>
<td>OE for File 7.0, 7.1</td>
</tr>
<tr>
<td>CLARiiON CX4-120, CX4-240, CX4-480, CX4-960</td>
<td>FLARE OE 4.30</td>
</tr>
<tr>
<td>Celerra NX4, NS-120, NS-480, NS-960</td>
<td>DART OE 5.6, 6.0</td>
</tr>
</tbody>
</table>

**Supported Languages**

The VNX Family Monitoring Reporting software is available in the following languages:

- English
- French

For more information on setting user language preferences, refer to [Edit user settings](#).

**Installing on Windows**

To install Monitoring and Reporting on Windows:

1. Double-click the install icon.
2. On the **Welcome** screen, click **Next**.
3. Read the license agreement and click **I Agree**.
4. Confirm the default location of the program files or click **Browse** to choose a different location.
5. When the installation completes successfully, click **Next**.
6. Click **Finish** to close the set up wizard and to launch Monitoring and Reporting.
Installing on Linux

To install Monitoring and Reporting on Linux:

1. Open a terminal session with the root user on your server.
2. Locate the installation package you downloaded.
3. Change the permissions of the installer so you can execute it. This example is for Linux 64 bit:
   
   ```
   # chmod +x setup-linux-x86_64-v22.sh
   ```
4. Run the script:
   
   ```
   # ./setup-linux-x86_64-v22.sh
   ```
5. Read the EULA and press y to accept it. To scroll through the EULA, use the space bar.
6. Press Enter to accept the default directory or enter another location and y to confirm.
7. Press Enter to accept the default account name or enter another one if you prefer.
8. Press Enter to accept the default location of service scripts or enter another location.
9. Press Enter to accept the default location of runlevels scripts or enter another location.
10. After the installation completes, read the Readme.

Deploying as a vApp

Note: Some of the vSphere menu navigation options described in this guide may vary slightly from the options you see in vSphere. Refer to the VMware documentation for details.

1. Download the VNX Family Monitoring and Reporting vApp files from EMC Online Support.
2. Open the vSphere Client and connect to the vCenter server that manages your VMware environment.
3. Select the resource pool where you want to deploy the VMs for VNX Family Monitoring and Reporting.
4. Select File > Deploy OVF template to launch the Deploy OVF Template wizard.
5. On the Source screen, locate the M & R ovf file and click Next. Sample: VNX_MnR_2.2.0_1VM_vApp.ovf
6. On the OVF Template Details screen, review the details and click Next.
7. Review the license agreement, click Accept, then click Next.
8. On the **Name and Location** screen:
   a. Accept the default name, or type a name for the appliance.
   b. Specify the location for the appliance within your VMware environment.
   c. Click **Next**.

9. Select the host or cluster where you want to run the deployed template and click **Next**.

10. On the **Storage** screen, select the destination storage for the virtual machine files and click **Next**.

11. In the **Disk Format** step, select the storage space provisioning method and click **Next**.

   **Note:** It is recommended that you use the Thin Provisioning format if the vApp will be deployed in a high-performance environment.

12. In the **Network Mapping** step, select a destination network that has an IP Pool associated with it for the VM and click **Next**.

13. In the **IP Address allocation** step, choose the IP allocation policy and IP protocol to use, then click **Next**.

14. In the **Properties** step, provide the values for the VM and click **Next**.

15. In the **Ready to Complete** step, review the list of properties for the appliance and click **Finish**.

   **Note:** You can also optionally select the **Power on after deployment** check box to power on the VM automatically once the deployment is complete.

---

**Upgrading the vApp**

**Pre-requisites**

- Note the name of the VNX M & R VM
- Take snapshots of the VNX M & R VM. Ensure that the datastore where the VM is running has sufficient free space for the snapshots. Consult your VMware administrator for more information.
- Ensure that a login with root credentials is available.

1. Download the updated VNX Family Monitoring and Reporting vApp files from EMC Online Support.

2. Validate that the checksum matches by clicking the Checksum link on the download page and using a local utility such as md5sum to generate the checksum.

   **Note:** Any changes that were made to the default firewall configuration by editing `etc/sysconfig/SuSEfirewall2.d/services/mr` will be overwritten during the upgrade with the original default configuration. Make a copy of this file so that you can again make the firewall configuration updates using the
usr/sbin/enable_firewall_port.sh script. This will preserve the custom configuration for all future upgrades. Run enable_firewall_port.sh for instructions on how to use the script.

**Update Linux Components**

To update the Linux components, complete the following steps for the VNX M & R VM.

1. Upload the VNX_MnR_2.2.0.0_vApp_Update.zip file to a temporary directory on the VM using a tool such as SCP.
2. Log into the VM host as root.
3. Extract the zip file `#unzip VNX_MnR_2.2.0.0_vApp_Update.zip`.
4. Navigate to the applianceUpdate directory.
5. Run the applianceUpdate script `./applianceUpdate`.

**IMPORTANT**

On the hosts, a firewall modification occurs. This modification may result in error messages such as FATAL: Could not load /lib/modules/2.1.101--0.35-default/modules/dep: No such file or directory after the modified firewall is reloaded, but before the upgrade script completes. These error messages can be safely ignored.

**Stage VNX Family M & R components on the VNX M & R VM deployed using the vApp Installer**

1. Log into the VM as root.
2. Navigate to the `usr/MnR_Source` directory and run the post-install script: `./post_install_sh`
3. Answer the questions presented in the wizard.

The new packages are installed in the /opt/APG/Tools/Module-Repository directory. If you have an installation without any other Linux or Windows servers, your system is now prepared for update. If you have any additional Linux servers deployed using the VM vApp, run the steps above on each of the deployments.

**Configuring the user process limits for Linux**

(Linux binary installs only)

For large deployments, increase the user process limits for the Monitoring and Reporting user account to a maximum of 65534. This modification enables Monitoring and Reporting services to open 65534 files and 65534 processes when needed.

1. Open a terminal session with the root user on your server.
2. Open the `/etc/security/limits.conf` file.
3. Add the following lines for the Monitoring and Reporting user (vnx or another name):
4. Save the file.

5. Type the following commands from the /bin directory of the installation to restart Monitoring and Reporting services (for example, from the /opt/VNX/bin directory):
   
   ```bash
   ./manage-modules.sh service stop all
   ./manage-modules.sh service start all
   ```

5. Issue the following command to verify the changes:
   
   ```bash
   # su vnx -c 'ulimit -n -u'
   ```

### System start

At the end of the installation process, system services are started and your default browser is opened to the URL where you can start configuring your system for data collection.

If you installed VNX Family Monitoring and Reporting on a Linux server, your browser will not open automatically. Point your browser to `http://<server-name>:58080/VNX-Config` to access the configuration page, replacing `<server-name>` with the name or IP address of the server where you installed the software. Monitoring and Reporting is a web application. You can access the web portal from systems on the network that can communicate with the Monitoring and Reporting server at this URL: `http://<server-name>:58080/VNX-MR`.

**IMPORTANT**

The first time you log in, the default user name is `admin` and the default password is `changeme`.

See Chapter 3, “Administration tasks,” for detailed information on how to configure and troubleshoot your system.
Uninstalling

To uninstall Monitoring and Reporting for Windows:
1. Go to Start > Control Panel > Uninstall a program.
2. Double-click on the program icon. Proceed through the uninstall wizard.

To uninstall Monitoring and Reporting for Linux:
1. Go to the executable directory
   ```bash
cd /opt/VNX/bin:
   ```
2. Stop services
   ```bash
   ./manage-modules.sh service stop all
   ```
3. Remove services
   ```bash
   ./manage-modules.sh service remove all
   ```
4. Remove the distribution
   ```bash
cd /opt
   rm -Rf VNX
   ```

Upgrading

**IMPORTANT**
If your Naviseccli files are installed in a custom location other than the default [Example: C:\Program Files (x86)\EMC\Navisphere\bin\naviseccli], ensure you have reset the path to the correct custom location after an upgrade. See the Registered Systems Page for more information.

Version 1.x to 2.x

There are two different methods of upgrading from a 1.x to 2.x version of Monitoring and Reporting: “In-place upgrade” and “Fresh Installation” (on a new host system). Select the method that best suits your needs.

**Note:** Chargeback will need to be reconfigured when upgrading to 2.x through either method.

In-place upgrade

The in-place upgrade for 1.x to 2.x versions of Monitoring and Reporting will preserve custom configuration settings including system settings, alerts, users, and scheduled reports, but will not preserve historical data collected by the 1.x version of Monitoring and Reporting.

1. Download Monitoring and Reporting for the VNX Family 2.0 from EMC Online Support.
2. Follow the procedures for installation for your host system, as described in “English” or “Installing on Linux”.

3. Reconfigure Chargeback, if previously set up on the 1.x instance.

**IMPORTANT**

Historical data from 1.x will be preserved on the 1.x host system in the following location: `Databases/MySQL/Default/data/apg_bak`. This data will not be fully readable by the 2.x instance of Monitoring and Reporting, but can be later moved to and accessed by a host system running Monitoring and Reporting 1.x. As this folder can take up considerable file space, it is recommended that you remove or archive this folder if you do an in-place upgrade to 2.x.

**Fresh Installation**

Fresh installation of Monitoring and Reporting 2.x will require a separate host system from that which is running Monitoring and Reporting 1.x. Running Monitoring and Reporting 1.x and 2.x on two separate systems is recommended if you need to preserve and access historical data from 1.x. You can discontinue use of the first host running 1.x once the 2.x instance has collected sufficient historical data for your system(s).

1. On the 1.x host system, stop the VNX Collector service. Leave all other services running.

2. On a new system, download Monitoring and Reporting 2.x from EMC Online Support.

3. Follow the procedures for installation for your host system, as described in “English” or “Installing on Linux”.

4. Reconfigure all previously customized settings, including system settings, alerts, user settings, Chargeback, and scheduled reports.

**Version 1.x to 1.x and 2.x to 2.x**

To upgrade Monitoring and Reporting, follow the same procedure used for installation. The system will automatically recognize that a previous version of Monitoring and Reporting is already installed and will proceed in Upgrade Mode.

**Note:** After an upgrade, you will need to use the default credentials, user name `admin` and password `changeme`, when you initially log in.
CHAPTER 3
Administration tasks

This chapter discusses administration tasks including:

- About Home Page ................................................................. 22
- Managing licenses ................................................................. 23
- Managing User Accounts ....................................................... 24
- Viewing Storage Systems ...................................................... 26
- Adding/Editing a System ....................................................... 26
- Alerting ................................................................................... 28
- Data Enrichment .................................................................... 31
- Backing up your system ....................................................... 35
- Retention parameters ........................................................... 36

These functions are available only to the VNX Family Monitoring and Reporting administrator
About Home Page

The home page is where you conduct certain administrative tasks related to your VNX Family Monitoring and Reporting software solution. These tasks include adding and managing systems and licenses, configuring global mail settings, and starting/stopping services. The home page shows the server system resource utilization, database storage utilization, and status of services that are performing various Monitoring and Reporting tasks.

The navigation on the left allows you to quickly go to the page dedicated to the specific action.

<table>
<thead>
<tr>
<th>Home</th>
<th>View system status, system storage consumption, and service statuses. From the service section, you can click a given service to start or stop it.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Licenses</td>
<td>Request permanent licenses, install and delete licenses.</td>
</tr>
<tr>
<td>Systems</td>
<td>List configured systems with their main properties. From this section, you can click on a given system to edit it.</td>
</tr>
<tr>
<td>Add New</td>
<td>Create a new system entry and open the corresponding configuration page.</td>
</tr>
</tbody>
</table>
The home page also shows data storage usage and allows you to control the services required to operate the application. The following table lists the system services and their functions.

<table>
<thead>
<tr>
<th>Service</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Alerting</td>
<td>Controls alert services</td>
</tr>
<tr>
<td>Backend</td>
<td>Receives raw data from the collection service and prepares data to be stored in the database.</td>
</tr>
<tr>
<td>Collecting</td>
<td>Controls data collection.</td>
</tr>
<tr>
<td>Database</td>
<td>Database service.</td>
</tr>
<tr>
<td>Event Processing</td>
<td>Receives raw data from collectors and computes TopN aggregates.</td>
</tr>
<tr>
<td>Gateway</td>
<td>Communication gateway for Monitoring and Reporting services.</td>
</tr>
<tr>
<td>Scheduler</td>
<td>Used to control processes that need to be run on a regular schedule.</td>
</tr>
<tr>
<td>Web Portal</td>
<td>Web container hosting the user interface.</td>
</tr>
</tbody>
</table>

**Managing licenses**

When you first install Monitoring and Reporting software, temporary licenses allow you to work for 90 days. During this period, you must request permanent licenses and install them for continuous monitoring and reporting of your storage systems.

From the management page, click **Licenses** on the navigation tree to access licensing options.

From the licensing page, you can **Request Permanent Licenses, Upload Licenses** that you have received, see which licenses are installed, and **Delete** licenses if needed. The search box allows you to look for specific words in the license names or descriptions.

**To add a license**

1. Click **Upload licenses**.
2. Browse and select the zip file that you have received from EMC.
3. Click **Ok**.

**To delete a license**

1. Click the corresponding checkbox to select the license, or use **All / Invert / None** to refine your selection.
2. Click **Delete**.
Managing User Accounts

VNX Family Monitoring and Reporting allows the creation of up to nine user accounts in addition to the default admin account, for a maximum of up to 10 users. Simultaneous user connections are unlimited.

There are two types of users: Normal User and Global Administrator. There can be only one Global Administrator for each Monitoring and Reporting license. The Global Administrator role is the default role created when you install Monitoring and Reporting. The administrator can create and manage other users.

Adding a new user

1. To add a new user, navigate to the Administration page and click Users.
2. Click New User.
3. Enter the required User Data fields. Note that Title, First Name, Last Name, and Email Address are optional fields. In order for a user to receive automated emails from Monitoring and Reporting, such as Schedule Reports, the Email Address field must be complete.

Edit an existing user

1. To edit an existing user, click on the user in the users list.
2. Click Edit.
3. From the User Modification page, edit the User Data fields.

Additional User Account Management tasks are described in Table 1, “User Account Management Tasks”.

Table 1 User Account Management Tasks

<table>
<thead>
<tr>
<th>User Management Task</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Edit</td>
<td>Edit User Data.</td>
</tr>
<tr>
<td>Copy</td>
<td>Copy a user to a new row. You will be required to enter the User Data.</td>
</tr>
<tr>
<td>Test User</td>
<td>Test and preview user settings by logging in as if you were that user.</td>
</tr>
<tr>
<td>Disable</td>
<td>Disable a user. Disabled users cannot log into the system.</td>
</tr>
<tr>
<td>Delete</td>
<td>Delete the user.</td>
</tr>
</tbody>
</table>

IMPORTANT

To reset user passwords, follow the instructions in “Edit an existing user” to update the password fields under User Data.

Edit user settings

1. On the main dashboard page, click Settings.
2. On the User Data tab, edit user settings, including name, password, and email address.
3. Click Save.
Edit user reporting preferences

1. On the main dashboard page, go to Settings.
2. On the Preference tab, edit the default language and Report Auto Refresh Rate, then click Save.
Viewing Storage Systems

The Systems section presents you with a global picture of the storage systems that are monitored by your application. Each defined system will have its entry in this table.

Click on a system to view detailed information or edit a system’s characteristics. The Add a New System button on the Registered Systems page or the Add New option of the navigation tree will open an empty configuration page where you can define a new system.

Adding/Editing a System

The Adding a System and Editing a System pages are where you specify the information required in order for Monitoring and Reporting to access your storage systems. You need to specify a unique name that will be used to identify this storage system and the type of data collection - Integrated Unified, Unified, Block-only or File-only - that should be applied to this unit. For Gateway systems, the data collection type should be File. Unified data only applies to integrated VNX systems that contain both block storage (SAN) and file storage (NAS) hardware components. Integrated Unified systems applies only to Next-Generation VNXe systems (VNXe3200). Mandatory fields are indicated with a red asterisk. Supported legacy CLARiiON CX4 and Celerra NS systems can also be added from this screen.

Note that it can take a few minutes before you can see information from a newly added system in the reporting portal. The software needs to poll the new system at least once to add metric information to the database.

When adding a system to Monitoring and Reporting, a Block or VNXe user account with the role of Operator is required to collect the configured Block data. A File local user account (such as nasadmin) is required to collect the configured File data. The selected user must be able to connect to the system using ssh for the collection mechanism to work, using group (role) administrator, fullnas, root, or storage. The VNX or CLARiiON array must be configured with “Statistics logging” enabled in order to provide all metrics to VNX Monitoring and Reporting.

<table>
<thead>
<tr>
<th>Block Collecting Information:</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>SP A/B IP</td>
<td>The IP address of each storage processor (A and B).</td>
</tr>
<tr>
<td>User Scope</td>
<td>Authentication scope. Global, local or LDAP.</td>
</tr>
<tr>
<td>Naviseccli Username</td>
<td>Username to be used to connect to Unisphere.</td>
</tr>
<tr>
<td>Naviseccli Password</td>
<td>Password to be used to connect to Unisphere.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>File Collecting Information:</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Control station IP</td>
<td>The IP address of the Control Station.</td>
</tr>
<tr>
<td>Username</td>
<td>Username to be used to connect to the Control Station.</td>
</tr>
<tr>
<td>Password</td>
<td>Password to connect to the Control Station.</td>
</tr>
</tbody>
</table>
VNXe Collecting Information

<table>
<thead>
<tr>
<th>Host</th>
<th>The IP address used to reach the VNXe server.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Username</td>
<td>VNXe username.</td>
</tr>
<tr>
<td>Password</td>
<td>VNXe password.</td>
</tr>
</tbody>
</table>

Registered Systems Page

The Registered Systems page allows you to edit the Naviseccli path and edit the polling intervals for both capacity and performance metrics (5, 15, or 60 minutes). The polling interval determines how often Monitoring and Reporting queries the storage systems for updated metrics. You can also Add a New System from this page, and manually refresh the data using the Retrieve missing information button.

Configuring Mail

VNX Family Monitoring and Reporting offers the option of emailing reports and alerts to users. This requires configuration of a valid SMTP (mail) server.

1. In the main configuration page, click the Global Settings button.
2. In the SMTP Host box, enter the name or IP address of the mail server. This may require the help of your local system administrator, especially if the default port 25 does not work or if the mail server requires a specific authentication scheme.

**IMPORTANT**

In order to receive emails, user profiles must include a valid email address.
Alerting

There are a variety of predefined alerts, which you can configure to trigger based on when certain performance thresholds are violated. You can also configure the alerts to trigger for only certain components, such as specific LUNs or SPs. Alerts are sent to Monitoring and Reporting users by email or captured by SNMP trap.

For example, for the LUN Response Time alert, you can set up an alert to trigger whenever a LUN response time is greater than 1 millisecond. Although the alerts are pre-defined, the threshold value and operator are set by the user. You can further configure this alert to trigger only when this threshold is surpassed for specific LUNs on specific systems.

There are five main components to configuring alerts: Configurable Data Filtering, where you can apply the alert to only certain components, Constant Comparator Operation, where the threshold condition is configured, Mail Action, where the email action is configured, SNMP v1Trap: SNMP Trap - Set, where the SNMP trap information is set, and SNMP v1 Trap: SNMP Trap - Clear, where the SNMP information is re-entered in order to clear the trap when the alert condition is no long occurring.

Note: Monitoring and Reporting does not support customization of community strings. The community string is enforced as “default”.

IMPORTANT
In order to receive email alerts, you must have email configured. Refer to “Registered Systems Page” for more information.

Enabling Alerts

1. Go to the Administration page.
3. Click Alert definitions in the menu tree on the left, or click Local Manager in the central pane.
4. Click directly on the row for the alert and select Enable. You will see an Operation Successful pop-up message when the alert has been enabled.

You will also notice that when clicking on the alert again, the Enable option will be replaced by the Disable option.

Configuring Alerts

1. Click on the alert name on the Alert Definitions page and select Configure. You can also click on the alert name in the alert tree to go to the configuration page for that alert.
2. In the Configurable Data Filtering section, you can enter the specific components to which to apply the alert threshold.
   a. To apply the alert to all components, leave the Selection drop-down option set to all.
b. To apply the alert to only certain components, set the **Selection** drop-down to **some**. Click the **Add values** button. A pop up window will appear, displaying all components to which you can apply the alert. Use the checkboxes to select the components and click **Ok**. This window also has a search bar which enables you to search for your components more quickly.

For example, for the LUN Response Time alert, you can select which LUNs to which you want to apply the alert.

3. In the **Constant Comparator Operation** section, enter the **Constant value** of the threshold condition and the **Operator**. For the list of available operators, refer to **Table 2, “Available Operators,”**. For the list of constant value units for each alert, refer to **Table 3, “Alert Constant Value Units,”**.

<table>
<thead>
<tr>
<th>Operator</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>&lt;</td>
<td>Less than</td>
</tr>
<tr>
<td>&lt;=</td>
<td>Less than or equal to</td>
</tr>
<tr>
<td>=</td>
<td>Equal to</td>
</tr>
<tr>
<td>&gt;</td>
<td>Greater than</td>
</tr>
<tr>
<td>&gt;=</td>
<td>Greater than or equal to</td>
</tr>
<tr>
<td>!=</td>
<td>Not equal to</td>
</tr>
</tbody>
</table>

4. In the **Mail Action** section, enter the email address of the user(s) to whom the alert should be sent. Recipient email addresses should be separated by a comma.
5. In the **SNMP v1 Trap: SNMP Trap - Set** section, enter the **Host** IP address and **Port** for the SNMP Trap.

6. In the **SNMP v1 Trap: SNMP Trap - Clear** section, reenter the **Host** IP address and **Port**. This will clear the trap when the alert condition is no longer being met.

7. Click **Save**.

**IMPORTANT**
Generally, you should not change the default **Message** template for the Alert emails. The contents of the message are designed to tell you exactly where the alert condition has been violated and the actual value which triggered the alert. For information on how to reset the Alert email message, refer to “Resetting the Alert email text” on page 51.

---

**Available Alerts**

**Table 3 Alert Constant Value Units**

<table>
<thead>
<tr>
<th>Alert Name</th>
<th>Unit</th>
</tr>
</thead>
<tbody>
<tr>
<td>Data Mover Processor Utilization</td>
<td>%</td>
</tr>
<tr>
<td>File System Percent Subscribed</td>
<td>%</td>
</tr>
<tr>
<td>LUN Response Time</td>
<td>milliseconds</td>
</tr>
<tr>
<td>Storage Pool Percent Subscribed</td>
<td>%</td>
</tr>
<tr>
<td>Storage Processor Dirty Pages Utilization</td>
<td>%</td>
</tr>
<tr>
<td>Storage Processor Utilization</td>
<td>%</td>
</tr>
</tbody>
</table>
Data Enrichment allows you to add metadata to the metrics collected by Monitoring and Reporting in order to enhance, or enrich, the data. Data Enrichment is located on the Administration page under Centralized Management.

Chargeback is a feature which uses Data Enrichment to determine the data cost-of-service of a business unit or application and displays it in the form of Chargeback Reports. There are two main components to configuring Chargeback: Business Unit and Cost. You can associate particular LUNs on an array with a business unit, application, and application owner. You then assign a cost value per gigabyte used for LUNs belonging to a certain RAID type and tier. Optionally, you can also specify cost per LUNs of a certain RAID type and tier on a specific array model. Chargeback will apply this cost to each gigabyte of data used by a LUN that meets the criteria you have defined for each business unit.

For example, logical unit number (LUN) 0 can be associated with the Development Business Unit. In the Cost section, you can configure any LUNs on a VNX5700 array with a RAID5 RAID Type which are part of the Performance Tier to incur a cost of $3.14 per GB used. If LUN 0 is a RAID5 LUN on the Performance tier on a VNX5700 array, the cost-of-service of the Development Business Unit will be $3.14 per GB used. The Chargeback Reports display the cost of service over time.

Multiple LUNs can be associated with a single business unit. Chargeback reports calculate the total cost-of-service of each business unit. For example, if a business unit is configured to have multiple LUNs, the cost per GB of each of those LUNs will be added to the total cost of service of the business unit.

You can also associate mixed LUNs with a particular business unit. Chargeback will calculate cost based on the percentage of storage allocated for that LUN by tier and RAID type.

There are several Chargeback reports which represent cost-of-service. These include Top 10 Applications by Cost, Top 10 Applications by capacity, Cost distribution by business unit, Cost per Business Unit, and Cost per Business Unit and Application.

To add a new Business Unit or Application to Chargeback:

1. Go to the Administration page.
2. Select Data Enrichment under Centralized Management.
3. Click localhost :: Default :: Data-Enrichment from the navigation tree on the left.
4. Expand the Business Unit section.
5. Add a new row by clicking the add/delete rows icon in the left-most column of an existing row and selecting Insert before or Insert after, depending on your preference.
6. Complete the rows according to the following table:

<table>
<thead>
<tr>
<th>Column Label</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>System Name</td>
<td>Add the name of the system.</td>
</tr>
<tr>
<td>Object Name</td>
<td>Add the name of the LUN. Use the format “Logical Unit Number X” where X is the LUN number.</td>
</tr>
<tr>
<td>Business Unit</td>
<td>Add the name of the Business Unit.</td>
</tr>
<tr>
<td>Application Name</td>
<td>Add the name of the application.</td>
</tr>
<tr>
<td>Application Owner</td>
<td>Add the name of the owning SP for the LUN.</td>
</tr>
</tbody>
</table>

7. Click **Save**.

To enter Cost:

1. Expand the **Cost** section. Rows will be pre-populated for each RAID Type and Tier combination. You will need to update the **System Model** and **Cost** column entries for each row.

2. Click an existing row in the **System Model** column. Enter the device model of the array. To apply the same Chargeback costs to each RAID type and tier for all array models, leave the default value of .* in this column.
3. Click an existing row in the **Cost** column. Edit the default value to the appropriate cost per GB for that RAID type on that tier.

**Note:** Cost values cannot include decimals.

4. Repeat steps 1-3 for the remaining rows as needed.

5. Click **Save**.

To add new rows to Cost:

1. Add a new row by clicking the add row icon in the first column of an existing row and selecting **Insert before** or **Insert after**, depending on your preference.

2. Complete the rows according to the following table:

<table>
<thead>
<tr>
<th>Column Label</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>System Model</td>
<td>Enter the device model of the array.</td>
</tr>
</tbody>
</table>
Administration tasks

3. Click **Save**.

**IMPORTANT**

If you are configuring Chargeback for mixed LUNs, be sure to associate costs with each tier and RAID type combination for those LUNs in the **Cost** section.

**WARNING**

Do not use the delete buttons to remove any existing columns from Chargeback. Doing so may prevent the Chargeback reports from working correctly. Do not use the **New Tagging**, **Add new key** or **Add new property** buttons.

<table>
<thead>
<tr>
<th>Column Label</th>
<th>Value</th>
</tr>
</thead>
</table>
| RAID Type    | Enter the RAID Type of the LUNs to which you are applying a cost value:  
  • RAID5  
  • RAID6  
  • RAID10 |
| Tier Name    | Enter the Disk Type of the LUN to which you are applying a cost value:  
  • Capacity  
  • Performance  
  • Extreme Performance |
| Cost         | Enter the cost value per gigabyte used by LUNs on that model and Tier with that RAID type. |
Backing up your system

It is essential that you back up the VNX Family Monitoring and Reporting solution on a regular basis. We recommend you back up data at the end of every business day and save the backed up information off-site.

The backup of the Monitoring and Reporting solution consists of two important parts: backing up the database and backing up the configuration files.

Backing up the database

Backing up the database requires the tables to be locked while the backup engine reads them. This can be done by using a script within the solution (in the bin directory) and periodically scheduling the task according to your needs. This process should be run overnight as the tables will not be updated with new values until the backup is finished. The script will lock the tables for two hours and unlock them automatically when the timer expires. Data collected during the backup operation is queued by the backend process and inserted in the database as soon as the lock is released.

Here is the list of recommended databases to back up:

- apg
- master
- storage
- topology

Backing up the configuration files

The second important part of the solution is the set of configuration files. The following is a list of sensitive directories to consider for backups:

- Databases
- Custom

Backing up these two directories will back up the following configuration files:

- Retention parameters
- Collector configurations
- Filters
- Listener configurations
- Databases connection strings
- Third party connections parameters
- Scripts
- Logs
- Temporary files
Retention parameters

Monitoring and Reporting collects new metrics every 5 minutes. This raw data is accumulated in hourly, daily and weekly aggregates that are used to display data on various time horizons. The retention policy for raw data and aggregates can be found in the table below. For example, Monitoring and Reporting allows you to report on weekly data for up to four years in the past.

<table>
<thead>
<tr>
<th>Accumulation period</th>
<th>Retention period</th>
</tr>
</thead>
<tbody>
<tr>
<td>5 minutes (raw data)</td>
<td>15 days</td>
</tr>
<tr>
<td>hourly</td>
<td>92 days</td>
</tr>
<tr>
<td>daily</td>
<td>365 days</td>
</tr>
<tr>
<td>weekly</td>
<td>4 years</td>
</tr>
</tbody>
</table>
CHAPTER 4
Viewing Reports

This chapter discusses the following topics:

◆ The web portal ................................................................. 38
◆ Search for components ..................................................... 40
◆ Display options ................................................................. 41
◆ Export reports ................................................................. 43
◆ Report tools ................................................................. 44
◆ Scheduling Reports ......................................................... 47

These features are available to all VNX Family Monitoring and Reporting users.
The web portal

On the left panel of the main page is a report tree where reports are organized into parent and child relationships. You can click any report name in the tree to display the corresponding report on the right.

The menu bar on the top right of your display offers a collection of tools:

<table>
<thead>
<tr>
<th>Search for reports</th>
<th>Look for a specific report using a combination of keywords.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Display options</td>
<td>Change the report time and time range settings</td>
</tr>
<tr>
<td>Export reports</td>
<td>Export the currently displayed report into a common format.</td>
</tr>
<tr>
<td>Report tools</td>
<td>Access the wizard and control favorites.</td>
</tr>
</tbody>
</table>
The report tree

The report tree on the left of the page is a dynamic hierarchical tree you use to navigate nodes.

You can browse the tree by clicking each entry, node icon, or node name, which displays that report in the main page area.

To expand or collapse nodes to view or hide their children, click the arrow for the entry or double-click the node icon or name.

You can resize the report tree panel by dragging the border.

Double-click the right edge of border to minimize or restore the panel to its default size.

Report tree elements:

<table>
<thead>
<tr>
<th>Element</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Favorite reports</td>
<td>Links to other reports in the template section of the report tree. You can add favorites as you browse the tree.</td>
</tr>
<tr>
<td>Summary and Details</td>
<td>Preconfigured templates accessed by all users. Each of these reports is common to all users who access them.</td>
</tr>
<tr>
<td>Scheduled Reports</td>
<td>Reports that are automatically generated at specified times.</td>
</tr>
<tr>
<td>My Reports</td>
<td>Displays user-configured reports. For example, reports with customized visual thresholds.</td>
</tr>
</tbody>
</table>
Search for components

You can use Search to quickly access a particular system or component. You can search by system name, model, or IP. The Search box is at the top of the dashboard.

1. In the Search box, type the keywords for the component and press Enter.

2. Click on the name of the system or component, or click Show all, and then the name of the system or component for which you want to view reports.
Display options

Information is presented in pre-configured graphics or tabular reports. The Display menu on the top of the dashboard allows you to change the display options for finer examination.

To change the report display options

1. From the Time Selection area, choose the type of aggregation the report uses and the time range it covers.

2. From the Display ___ values list, choose an aggregate time period. Real-time values are aggregated as they are collected. Other aggregation time periods are available. The defaults can be changed by your administrator. The defaults are:
   - real-time: the real collected values
   - 1 hour: 1 hour aggregates
   - 1 day: 1 day aggregates
   - 1 week: 1 week aggregates

3. From the Using ___ Aggregation list choose the type of aggregation you want to use.

4. From the time range list, select the time period the report will cover. You can use the Time Range Quick Switch arrows to choose the previous or next periods.

5. Choose a value from the Over field if you are using a custom range.
   - Previous: selects the entire previous range. For example, the previous day is from midnight to the midnight the day before, and the previous one month includes the entire month’s time, so if it is now September 10th the period would include all of August.
   - Last: selects one range back from now. For example, the last day extends from the current time back 24 hours, and the last month extends from the current day back a period of one month.
   - Current: selects the current range. For example, the current day extends from the last midnight through to the current time and forward to the next midnight, and the current month extends from the first of the current month to the last day of the month.

6. From the second field, select a time range. You can choose a pre-defined value or period. For greater accuracy, you can select custom or calendar.
   - For calendar, specify the start and end times of the report.
Viewing Reports

- For **custom**, specify a duration using numbers and units. There is no limit to the number of units, but each unit can be present only once. For example, 1h45m is translated as 1 hour and 45 minutes.

7. To lock the time frame, click the lock icon. If you lock the time frame, the time selection parameters that you chose are applied to every report you view during the current session. This can be used for obtaining snapshots-in-time in order to compare equivalent graphs for a device.

8. From the **Actions** area, choose the actions you want to take. Click **Apply** or your changes will not take effect.

- Choose **View in Full Page** to display only the contents of the reports currently in the page area in a new browser tab or window. Other user interface elements, including the report menu, do not appear.
- Choose **Revert to Default** to revert the report to its default settings. The **Revert to Default** option can also be used to refresh the report that is currently displayed.

**Note:** For Heat Map reports, you cannot click directly on the graphical interface to change the view or parameters. The default view is static.
Export reports

Reports can be exported into various formats. The export formats available will vary slightly from report to report. Unavailable export options will be greyed-out.

To export a report

1. Select the node for the report you want to export.

Export formats

<table>
<thead>
<tr>
<th>Format</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>PDF document</td>
<td>Creates a PDF and opens it in a window where you can save it or print it.</td>
</tr>
<tr>
<td>CSV format</td>
<td>Exports the report in a CSV file. If this is a multipart report, each part is prepended with a commented line containing the title of the part. For graphs, data is exported according to the graph type.</td>
</tr>
<tr>
<td>XLS format</td>
<td>Exports the report in an XLS file. If it is a multipart report, each part is exported in a separate sheet. For graphs, data is exported according to the graph type. If you choose XLS 1 column, all of the values are displayed in one column.</td>
</tr>
<tr>
<td>PNG, JPEG or SVG image</td>
<td>Creates an image of the report's first graph. If there is no graph on the exported report, an empty image is generated.</td>
</tr>
<tr>
<td>XML format</td>
<td>Exports the report as an XML file.</td>
</tr>
</tbody>
</table>
Report tools

The Tools menu gives you access to the Report Wizard and has tools for printing, emailing reports and adding them to your Favorites.

To access report tools

1. Select a report node from the tree.

<table>
<thead>
<tr>
<th>Report tools</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Report Wizard</td>
<td>Opens the Report Wizard from which you can create a new report.</td>
</tr>
<tr>
<td>Show Report URL</td>
<td>Replaces the current URL with the complete report URL. This enables you to create a bookmark for this page or directly link to it.</td>
</tr>
<tr>
<td>Print this Report</td>
<td>Generates the report in printable format.</td>
</tr>
<tr>
<td>Add to Favorite Reports</td>
<td>Adds the current report to the Favorite Reports. These reports are listed on the top of the tree for quick access.</td>
</tr>
<tr>
<td>E-mail me this Report</td>
<td>Generates the report and sends it as a PDF attachment to the email address configured in your settings.</td>
</tr>
<tr>
<td>Schedule this Report</td>
<td>Generates the report at scheduled intervals and sends it as a PDF attachment to the email address configured in your settings.</td>
</tr>
</tbody>
</table>
The Report Wizard

You can use the Report Wizard if you are troubleshooting an issue and you want to access data quickly. This is also a helpful tool to compare metrics for troubleshooting purposes.

To use the Report Wizard


2. From the View Type list select a view type. The available views are defined by the system's administrator.

3. In the Available Elements area, select elements to filter on. You can click the filter icon and start typing the name of an element to filter the list. Continue to choose elements until you define all the elements you want included.

4. If you can select more metrics to add to the report, the Add Metrics button becomes available. You can click it and repeat steps 3 and 4 until you have all the metrics you want to add to your report.

5. Click Run to generate the report.
Example of creating a report with the Report Wizard

This example shows how to create a report that displays CPU utilization for a number of Data Movers.

1. On the **Tools** menu click **Report Wizard**.

2. Choose these options:
   - **Devices**: Select a serial number.
   - **Type**: DataMover.
   - **Devices**: Select all.
   - **Component Types**: Processor.
   - **Components**: CPU/0.
   - **Available Metrics**: CurrentUtilization.

3. Click **Run**. You can save the report to My Reports to rerun it.
Scheduling Reports

Reports can be scheduled to be generated at specific times and delivered by email to recipients as PDFs. Whenever a report is scheduled to be generated, it queries the database for the latest data.

To schedule a report:

1. Browse to the report you would like to schedule using the Report Tree.
2. Go to Tools > Schedule this Report.
3. On the Scheduling tab of the New Scheduled Report window, enter the name of the scheduled report, select how frequently the scheduled report should generate, and select the time zone.
4. On the Email tab, enter the email addresses of the recipients for the scheduled report.

5. Click Save.

Note: Scheduled reports maintain the default display settings. To schedule a report with modified display settings, such as a custom time range, click Save modified report rather than Save.

Modifying a scheduled report

1. In the report tree, click Scheduled Reports. A list of scheduled reports will display in the main window.

2. Click on the name of the report you want to modify. A list of several options will appear, including Edit. Click Edit to modify the report settings.

3. On the Editing Scheduled Report screen, update the report name, schedule, and email recipients as needed. Click Save.
CHAPTER 5
Troubleshooting

The content of this document describes the paragraph tags, character tags, and cross-reference formats supported in this chapter template.

- Common Issues ...................................................................................................... 50
- Resetting Alerts..................................................................................................... 50
Common Issues

The following table lists common issues:

<table>
<thead>
<tr>
<th>Issue</th>
<th>Resolution</th>
</tr>
</thead>
</table>
| No data or partial data is showing in the reports | Ensure that:  
- No firewall is blocking access between the server running data collection and storage systems  
- All Monitoring and Reporting services are up and running,  
- Database storage has disk capacity  
- The server date and time are accurate  
- Your storage systems are available and accessible for the application |
| Cannot login to the portal                      | Ensure that:  
- You are accessing the right URL and port:  
  http://portal_ip:58080/VNX-MR  
- All passwords are case sensitive. Confirm that you do not have CAPS LOCK on and that you are entering your password with the correct case. |
| The portal page does not appear                 | Ensure that:  
- All Monitoring and Reporting services are up and running  
- You tried the portal IP instead of its hostname in the URL  
- Your browser proxy settings are correct (check with your local administrator) |
| A licence error appears at login page           | Note the error message and contact support. |

Resetting Alerts

Resetting alerts can be used to reset the configuration for all alerts, including the alert email template. To reset only the alert email text, refer to “Resetting the Alert email text” on page 51.

IMPORTANT

Resetting the alerts will remove any existing alert configuration. For example, if you have configured some alerts to trigger for only certain components, such as only certain LUNs, this configuration will be removed when you reset all alerts.

On Linux:

1. Remove the existing alert configuration file:

   `rm/opt/VNX/Backends/Alerting-Backend/Default/conf/alerting.xml`

2. Update the module, which will reinstall the configuration file:

   `/opt/VNX/bin/manage-modules.sh update alerting-backend`

3. Stop and restart Alerting services. From the Monitoring and Reporting Home page,  
   Select Alerting > Stop Process.

On Windows

1. In Windows Explorer, navigate to Program Files > VNX > Backends > Alerting-Backend > Default > conf.
2. Delete the existing alert configuration xml file alerting.xml.
3. Create a new alert configuration file by opening a command prompt window and entering the following command:

   /opt/VNX/bin/manage-modules.sh update alerting-backend

4. Stop and restart Alerting services. From the Monitoring and Reporting Home page, Select Alerting > Stop Process.
5. Select Alerting > Start Process.

Resetting the Alert email text

1. Select the alert for which you want to reset the email text.
2. Expand Mail Action: Mail template. Enter the following text in the Message field:

   PROP.'device' PROP.'parttype' PROP.'part' has exceeded the threshold, the current value is VALUE PROP.'unit'

3. Click Save.

Table 6 Alert email template variables

<table>
<thead>
<tr>
<th>Variable</th>
<th>Description</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>device</td>
<td>System Name</td>
<td>Array 123</td>
</tr>
<tr>
<td>parttype</td>
<td>Component type</td>
<td>LUN</td>
</tr>
<tr>
<td>part</td>
<td>Specific component</td>
<td>LUN 101</td>
</tr>
<tr>
<td>unit</td>
<td>Current value which violated the alert condition, triggering the alert</td>
<td>If alert condition is LUN Response Time greater than 1 millisecond, the actual unit value would be any value over 1 ms</td>
</tr>
</tbody>
</table>
Figure 1  Alert email example
# APPENDIX A

Available reports and metrics

**VNX Block/CLARiiON (All Reports)**

<table>
<thead>
<tr>
<th>Parent</th>
<th>Report Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>VNX Block / CLARiiON</td>
<td>Storage Processor Utilization (%)</td>
<td>Percentage of time that the SP was busy serving incoming requests.</td>
</tr>
<tr>
<td>Storage Processor Utilization (%)</td>
<td>Dynamic expansion on all controllers</td>
<td>Per controller CPU usage for both Storage Processors A and B.</td>
</tr>
<tr>
<td>VNX Block / CLARiiON</td>
<td>VNX Block Arrays Summary</td>
<td>Raw Capacity Total, Raw Capacity Free, Usable Capacity, Logical Free Capacity and Element in Problem.</td>
</tr>
<tr>
<td>VNX Block Arrays Summary</td>
<td>Block Usable Capacity</td>
<td>Distribution of used and free space for all arrays.</td>
</tr>
<tr>
<td>VNX Block Arrays Summary</td>
<td>Distribution by Model</td>
<td>Distribution of arrays according to their model (CX, VNX,...).</td>
</tr>
<tr>
<td>VNX Block Arrays Summary</td>
<td>Distribution by Version</td>
<td>Distribution of arrays according to their FLARE or Block OE version.</td>
</tr>
<tr>
<td>VNX Block Arrays Summary</td>
<td>Dynamic expansion on all arrays</td>
<td>A complete report showing volume distribution per array.</td>
</tr>
<tr>
<td>VNX Block / CLARiiON</td>
<td>Inventory</td>
<td>Complete inventory of all monitored components.</td>
</tr>
<tr>
<td>Inventory</td>
<td>Dynamic expansion on device types</td>
<td>Inventory of all Arrays, SPs, LUNs, RAID Groups, Storage Pools, Storage Groups, Disks, Hosts, Ports and Applications.</td>
</tr>
<tr>
<td>Performance</td>
<td>Storage Pools IOPS Bottleneck</td>
<td>Read / Write IOPS Capability.</td>
</tr>
<tr>
<td>Performance</td>
<td>LUN Performance Bottleneck</td>
<td>Performance report listing all Logical Unit numbers’ Utilization and queue length.</td>
</tr>
<tr>
<td>Performance</td>
<td>LUN Read Cache</td>
<td>Pre-fetched percentage used and hit ratio per LUN.</td>
</tr>
<tr>
<td>Performance</td>
<td>TopN &amp; Exceptions</td>
<td>IOPS, Performance Analysis, Disk and LUNs Errors, Disk Fragmentation.</td>
</tr>
<tr>
<td>Performance</td>
<td>Disk Utilization Heat Map</td>
<td>This report shows disk utilization for a given array.</td>
</tr>
<tr>
<td>Performance</td>
<td>SP Utilization Heat Map</td>
<td>This report shows SP utilization by array.</td>
</tr>
<tr>
<td>VNX Block / CLARiiON</td>
<td>Capacity Planning</td>
<td>Space Capacity Planning, Storage Pool Capacity Planning.</td>
</tr>
</tbody>
</table>
### Available reports and metrics

<table>
<thead>
<tr>
<th>Parent</th>
<th>Report Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Capacity Planning</td>
<td>Space Capacity Planning</td>
<td>This report shows Provisioned Usable Capacity.</td>
</tr>
<tr>
<td>Capacity Planning</td>
<td>Storage Pool Capacity Planning</td>
<td>This report shows when you should expect an array to reach its full disk capacity.</td>
</tr>
<tr>
<td>VNX Block / CLARiiON</td>
<td>Health</td>
<td>Arrays Compliance Forecast, Broken Disks.</td>
</tr>
<tr>
<td>Health</td>
<td>Arrays Compliance Forecast</td>
<td>This report shows disk arrays availability and offers SLA results for the last month.</td>
</tr>
<tr>
<td>Health</td>
<td>Broken Disks</td>
<td>List of all broken disks. If no data is available in this list, there are no known broken disks.</td>
</tr>
<tr>
<td>VNX Block / CLARiiON</td>
<td>Chargeback Reports</td>
<td>Calculates cost-of-service of business units</td>
</tr>
<tr>
<td>Chargeback Reports</td>
<td>Top 10 Application by Cost</td>
<td>This report displays the top 10 most costly applications.</td>
</tr>
<tr>
<td>Chargeback Reports</td>
<td>Top 10 Application by Capacity</td>
<td>This report displays the top 10 applications by provisioned usable capacity.</td>
</tr>
<tr>
<td>Chargeback Reports</td>
<td>Cost distribution by Business Unit</td>
<td>This report shows the distribution of overall cost among the business units.</td>
</tr>
<tr>
<td>Chargeback Reports</td>
<td>Cost per Business Unit</td>
<td>This report displays the cost per business unit over the last four months.</td>
</tr>
<tr>
<td>Chargeback Reports</td>
<td>Cost per Business Unit and Application</td>
<td>This report displays the cost per business unit, application, and application owner over the last four months.</td>
</tr>
</tbody>
</table>
# VNX File / Celerra (All Reports)

<table>
<thead>
<tr>
<th>Parent</th>
<th>Report Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>VNX File / Celerra</td>
<td>VNX File CPU Utilization (%)</td>
<td>Per File/Celerra Server Processor Utilization in percentage.</td>
</tr>
<tr>
<td>VNX File / Celerra</td>
<td>Dynamic expansion on all servers</td>
<td>Graph report showing CPU usage of each File/Celerra server.</td>
</tr>
<tr>
<td>VNX File / Celerra</td>
<td>Protocol Overview / DM</td>
<td>Number of opened files, total calls (ops/s) per server, according to protocol.</td>
</tr>
<tr>
<td>Protocol Overview / DM</td>
<td>Dynamic expansion on all servers</td>
<td>Number of opened files, total calls (ops/s) per server, according to protocol.</td>
</tr>
<tr>
<td>VNX File Summary</td>
<td>VNX File Summary</td>
<td>Displays a report on Total IO and severity per Serial Number/Device.</td>
</tr>
<tr>
<td>VNX File Summary</td>
<td>Dynamic expansion on serial numbers</td>
<td>Dashboard showing Data Movers, Storage pools, File Systems, IO and Throughput.</td>
</tr>
<tr>
<td>VNX File / Celerra</td>
<td>Capacity</td>
<td>File system usage forecast.</td>
</tr>
<tr>
<td>Capacity</td>
<td>All Filesystems</td>
<td>Usage forecast and prediction per File System.</td>
</tr>
<tr>
<td>Capacity</td>
<td>Deduplication</td>
<td>Report showing saved space due to deduplication per File System.</td>
</tr>
<tr>
<td>Capacity</td>
<td>Filesystems and Savvols Utilization</td>
<td>Utilization and Savvol stats for all File Systems.</td>
</tr>
<tr>
<td>Capacity</td>
<td>Filesystems Used Forecast</td>
<td>Total File System usage trending for the last week.</td>
</tr>
<tr>
<td>Capacity</td>
<td>Savvols</td>
<td>Defined Savvols and their capacity.</td>
</tr>
<tr>
<td>VNX File / Celerra</td>
<td>Performance</td>
<td>Celerra's IO and throughput information, per server.</td>
</tr>
<tr>
<td>Performance</td>
<td>CIFS open Connections</td>
<td>The number of open connections over the last day.</td>
</tr>
<tr>
<td>Performance</td>
<td>CIFS open Files</td>
<td>The number of open files over the last day.</td>
</tr>
<tr>
<td>Performance</td>
<td>CIFS Ops/s</td>
<td>CIFS operations per second over the last day.</td>
</tr>
<tr>
<td>Performance</td>
<td>NFS Ops/s</td>
<td>NFS operations per second over the last day.</td>
</tr>
<tr>
<td>Performance</td>
<td>Top 5 CIFS users</td>
<td>This table report shows a list of top CIFS Read/Write users.</td>
</tr>
<tr>
<td>Performance</td>
<td>Top 5 NFS clients</td>
<td>This table report shows a list of top NFS Read/Write users.</td>
</tr>
<tr>
<td>VNX File / Celerra</td>
<td>Inventory</td>
<td>Number of Data Movers, File systems, Shares and CS.</td>
</tr>
<tr>
<td>Inventory</td>
<td>Data Movers</td>
<td>Status, uptime, CPU and memory utilization.</td>
</tr>
<tr>
<td>Inventory</td>
<td>FileSystems</td>
<td>Utilization, size and throughput.</td>
</tr>
<tr>
<td>Inventory</td>
<td>NFS Shares</td>
<td>Name, path and server for each share.</td>
</tr>
<tr>
<td>Inventory</td>
<td>CIFS Shares</td>
<td>Name, maximum users, path and server.</td>
</tr>
<tr>
<td>Inventory</td>
<td>ControlStation</td>
<td>Control stations with their availability.</td>
</tr>
<tr>
<td>Inventory</td>
<td>System</td>
<td>Systems with their availability.</td>
</tr>
</tbody>
</table>
## VNXe (All reports)

<table>
<thead>
<tr>
<th>Parent</th>
<th>Report Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>VNXe</td>
<td>Capacity</td>
<td>Displays raw capacity by:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• <strong>Configured Usable</strong>: Configured capacity that is available for data storage.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• <strong>Hot Spare</strong>: Capacity of all hot spares on the array.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• <strong>RAID Overhead</strong>: Array capacity used to support RAID protection overhead.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• <strong>Unconfigured</strong>: Total capacity that is available for the creation of LUNs, RAID groups, storage pools or hot spares.</td>
</tr>
<tr>
<td>Capacity</td>
<td>Raw Capacity</td>
<td>Displays usable capacity by:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• <strong>Free</strong>: Unbound data devices and SAVE devices, unmapped and/or unmasked thick LUNs.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• <strong>Pool Free</strong>: Unwritten space within pools and unbound capacity within RAID groups.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• <strong>Used For Block</strong>: Capacity that is made available to storage area network.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• <strong>Used For File</strong>: Capacity that is made available to network attached storage.</td>
</tr>
<tr>
<td>Capacity</td>
<td>Usable Capacity</td>
<td>Displays the capacity of the system as used for the following purposes:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• <strong>Local Replica Used</strong>: Array capacity that has been mapped, masked, and configured as local replicas. This capacity is commonly used for testing and backup.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• <strong>Primary Used</strong>: Array capacity that has been mapped, masked, and configured for the primary storage of application data. This does not include copies.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• <strong>Remote Replica Used</strong>: Capacity used for remote copies, commonly for disaster recovery.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• <strong>System Used</strong>: Capacity reserved for use by the array for internal operations.</td>
</tr>
<tr>
<td>Capacity</td>
<td>Usable Capacity by Purpose</td>
<td>Displays the following capacity types over time:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• <strong>Block Used Capacity</strong>: Total capacity used by Block Services.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• <strong>File Used Capacity</strong>: Total capacity used by File Services.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• <strong>Free Capacity</strong>: Total free capacity.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• <strong>Pool Free Capacity</strong>: Free capacity within storage pools.</td>
</tr>
<tr>
<td>Capacity</td>
<td>Usable Capacity Trend</td>
<td>Displays capacity by storage pool.</td>
</tr>
<tr>
<td>Capacity</td>
<td>Usable Capacity by Service Level</td>
<td>Displays capacities for each service level. Service level is based on disk type, disk size, RAID type and FAST cache status (enabled/disabled). For FAST LUNs, Service Level is based on pool name, tiering policy name, and FAST cache status (enabled/disabled). Service levels include:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• <strong>Platinum</strong>: Flash Drive</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• <strong>Gold</strong>: Fibre Channel, RAID-1</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• <strong>Silver</strong>: Fibre Channel, RAID-5</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• <strong>Bronze</strong>: SATA Drive</td>
</tr>
</tbody>
</table>
## Available reports and metrics

<table>
<thead>
<tr>
<th>Parent</th>
<th>Report Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Capacity</td>
<td>Storage Capacity Presented to NAS</td>
<td>• <strong>Disks Used</strong>: Storage Capacity of production file systems and their overhead, storage capacity of SavVols and Free NAS Pool capacity.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• <strong>Free Capacity on Used Disks</strong>: Storage Capacity of free partitions, free metavolumes and free space on partially used NAS Disks.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• <strong>System Resource</strong>: Storage Capacity of NAS Disks used for internal file systems.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• <strong>Unused Disks</strong>: Storage Capacity of non-partitioned NAS Disks.</td>
</tr>
<tr>
<td>Capacity</td>
<td>NAS disks used breakdown</td>
<td>• <strong>Usable File System</strong>: Storage capacity of production file systems on NAS Disks or NAS Pools.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• <strong>NAS Pool Free</strong>: Free NAS Pool capacity that is available to create production file systems and SavVols.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• <strong>Usable SavVol</strong>: Storage capacity of SavVols on NAS Disks or NAS Pools.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• <strong>File System Overhead</strong>: Reserved overhead capacity to support a production file system.</td>
</tr>
<tr>
<td>Capacity</td>
<td>NAS File systems Usage</td>
<td>• <strong>File System Used</strong>: Used capacity of production file systems.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• <strong>NAS Pool Free</strong>: Free capacity of production file systems.</td>
</tr>
<tr>
<td>Performance</td>
<td>NAS Servers</td>
<td>Displays NAS servers and their attributes.</td>
</tr>
<tr>
<td>Performance</td>
<td>LUN / Summary</td>
<td>Displays list of LUNs and attributes, LUN Groups, and LUN performance.</td>
</tr>
<tr>
<td>Performance</td>
<td>Disks / Summary</td>
<td>Displays list of disks and attributes.</td>
</tr>
<tr>
<td>Performance</td>
<td>Storage Pools</td>
<td>Displays all storage pools and their attributes, including: capacity, used disks, FAST VP Capacity, and FAST VP Movements by Tier.</td>
</tr>
<tr>
<td>Performance</td>
<td>File Systems / Summary</td>
<td>Displays File Systems and their attributes, including capacity and deduplication.</td>
</tr>
<tr>
<td>Performance</td>
<td>Throughput</td>
<td>Displays system read and write throughput.</td>
</tr>
<tr>
<td>Performance</td>
<td>Shares</td>
<td>Displays all shares, including type and associated server.</td>
</tr>
<tr>
<td>Performance</td>
<td>CIFS/NFS Performance / Summary</td>
<td>Displays CIFS and NFS servers and performance attributes, including Throughput, IOPs, Operations, Connections, and Open files.</td>
</tr>
<tr>
<td>Performance</td>
<td>FAST Cache / Summary</td>
<td>Displays FAST Cache attributes including Cache Dirty pages by storage processor, FAST Cache valid elements, Total Cache Dirty Size, Total Cache Throughput / IOPs.</td>
</tr>
<tr>
<td>Performance</td>
<td>FAST VP / Summary</td>
<td>Displays FAST VP attributes, including Move Down Capacity, Move within capacity, and Moving up capacity.</td>
</tr>
</tbody>
</table>
Available reports and metrics
APPENDIX B
Communication Ports

The following table lists IP ports used by VNX Family Monitoring and Reporting services. TCP port 58080 must be open between browsers and the VNX Family Monitoring and Reporting server for browsers to access the application.

<table>
<thead>
<tr>
<th>Port</th>
<th>Service</th>
</tr>
</thead>
<tbody>
<tr>
<td>TCP/2000</td>
<td>Backend</td>
</tr>
<tr>
<td>TCP/2001</td>
<td>Backend</td>
</tr>
<tr>
<td>TCP/48443</td>
<td>Gateway</td>
</tr>
<tr>
<td>TCP/53306</td>
<td>Database</td>
</tr>
<tr>
<td>TCP/58080</td>
<td>Web Portal</td>
</tr>
</tbody>
</table>

The following table lists IP ports used by VNX Family Monitoring and Reporting to access arrays. These ports need to be opened from Monitoring and Reporting to VNX and VNXe arrays.

<table>
<thead>
<tr>
<th>Port</th>
<th>Technology</th>
</tr>
</thead>
<tbody>
<tr>
<td>TCP/443</td>
<td>naviseccli (SP IP) and XML/API (CS IP)</td>
</tr>
<tr>
<td>TCP/22</td>
<td>SSH (VNX File CLI)</td>
</tr>
</tbody>
</table>
INDEX

A
administrative tasks 22
Alerting 28
architecture 10

B
backup 35

C
Chargeback 31

D
Data Enrichment 31
display options
  apply change 42
drift 41
  full page 42

E
Export 43

F
Favorite reports 39
full page, report 42

H
hardware requirements 12

I
Installation 13, 14

L
licenses 23
lock time frame 42

P
password 17

R
refresh 42
report
  display options 42
  full page 42
  Report Wizard 45, 46
  search 40
  view in full page 42
report tree 38, 39
Report Wizard 45, 46

S
scheduling reports, scheduled reports 47
Search 40
search 40

T
time drift
display options 41
time frame 42
  lock 42
tools 44
tree
    minimize 39
Troubleshooting 49

U
URL 17
user name 17

V
VNX Block Reports 9
VNX File Reports 9
VNX Monitoring and Reporting 8
VNX System
  add 26
  edit 26